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What Is IconBuilder?

IconBuilder is a filter for use with Adobe Photoshop™ that makes creating icons a
snap. IconBuilder combines the power and flexibility of Photoshop with the ease of
use of the Mac OS to make a powerful icon creation tool for both beginner and
advanced users. The filter comes in two versions - IconBuilder Lite and IconBuilder Pro.
The feature sets between these two versions vary slightly and you’ll want to examine
which version best fits your needs prior to registering the software. IconBuilder Pro
has all of the functionality of Lite plus the added ability to construct icons for the
Windows operating system (95, 98, NT, 2000) as well as extended support for creating
icons for Mac OS X.

Written by veteran Photoshop filter author - Craig Hockenberry, IconBuilder is an ideal
"real world" solution for creating 32 bit icons for the numerous versions of the Mac
OS, including thumbnail (128x128 pixel) icons in OS X. Thanks to the use of layers
(and their transparent properties), Photoshop makes the perfect editor to create the
blended shadows, smooth outlines and translucent areas that modern icons demand.
IconBuilder has the ability to translate any kind of transparent effect done in Photoshop
layers, quickly and easily into icons for Mac OS 8.5, Mac OS X and beyond.

Keep in mind that IconBuilder itself is not an icon editor. You use Adobe Photoshop
as your editor, in combination with IconBuilder as your assembly tool. Using this
method, making icons has never been easier!

Summary of Common (Pro & Lite) Features
• Creation of true 32 bit icon formats for Mac OS 8.5+
• Supports transparent/translucent masking of icons
• QuickBuild™ feature creates all icon resources in a single click
• Extract any icon (including its mask) into Photoshop for editing
• Cycle backgrounds to view icons against a variety of desktops
• Instant access to "BuilderTips" for novice and advanced users
• IconBuilder does it all - no need for additional icon editors

Additional Features of IconBuilder Pro
• Creation of Windows based .ico file formats (WIN 95, 98, NT, 2000)
• Creation of thumbnail (128x128 pixel) icon format in Mac OS X
• Ability to dynamically scale the appearance of the thumbnail icon

   (this simulates how the icon will be redrawn in the Mac OS X Dock)

System Requirements (both Pro & Lite versions)
• A Macintosh computer with a PPC processor
• Adobe Photoshop™ 3.0 (PPC) or later
• Mac OS 8.5 or later
• Screen resolutions at or above 800x600 pixels

Please see the next page for a complete list of features.

An Introduction

IconBuilder Pro Package - The Pro version of IconBuilder comes
with additional tools and helpful tips for creating icons for the
Windows and Mac OS X platform.
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IconBuilder was created by people who love to make icons. We wanted a tool that
fit our needs both as hobbyists and professionals. For a more in-depth assessment of
IconBuilder’s extensive feature set, please read below.

Creation of true 32-bit icon formats - By combining custom icon data (that you
create or import) as well as 1 bit or 8 bit transparent masks from Adobe Photoshop
layers, IconBuilder can create transparent icons on the desktop in a matter of seconds.

Supports transparent/translucent masking of icons - Thanks to the 256 levels of
transparency possible in a standard Photoshop layer, IconBuilder is able to read these
levels and create transparent masks quickly and effectively. Multiple layers can even
be combined to create complex transparent or translucent masks that can then be
applied to standard icons. You can make the masks yourself, or have IconBuilder make
them for you.

QuickBuild feature creates all icon resources in a single click - If you want the
ease of creating all versions of an icon instantly, IconBuilder's "QuickBuild" feature
gives it to you. Using this feature, you can get all the basic resources (data and masks)
created and saved. If you want to go back and tweak them afterwards, that's a snap
too.

Import any icon into Photoshop for editing - With IconBuilder's "Import" feature
you can import any existing Mac icon and see, for instance, how a particular icon's
8 bit mask was created. Using the "Apply View to Photoshop Layer" feature, you can
then paste either the icon's visual data, the icon's mask, or both back out into Photoshop
for editing.

Cycle backgrounds to view icons on a variety of desktops -  Want to know what
your transparent icon will look like against a background other than gray? IconBuilder
lets you select from a multitude of solid colors as well as detailed desktop textures to
display your work against. Check how your icons look against both "normal" and
"funky" Macintosh desktops.

Instant access to "BuilderTips" for novice and advanced users - The filter comes
with roll-over help called "BuilderTips" to help you find your way around the interface
until you're comfortable with the controls. These tips can then be turned off or on
when needed. When in the “off” mode, BuilderTips displays the name and current
file size of the icon you’re working with.

IconBuilder does it all - no need for additional icon editors - Perhaps IconBuilder's
greatest strength is that it is a one-stop tool for creating icons. Since the filter makes
use of the ultimate graphics editor - Adobe Photoshop, for its editing tools, icon artists
need no longer look to multiple programs like ResEdit or Resourcerer to create icons.
This becomes especially true as artists move away from the traditional “pushing pixels”
approach so common in classic icons, to the more modern “image editing” of Mac
OS X icons.

Draw your work on Photoshop layers, launch the filter, build the icon and save. If you
need to tweak your work, simply open the saved icon and edit it in IconBuilder or
make changes to your original layers file. In addition, creating icons from layers adds
the flexibility to move, arrange, resize, recolor or remask whole or parts of icons quickly.

Additional Features
• Reports file sizes of icons as you build them
• Supports Mac OS 8.5 Navigation Services
• Intuitive, easy to use interface

A Complete List of Features

The power of Macintosh 8-bit masks - If you look closely at these
two trash can icons, you can see how the background pattern of
the desktop shows through the translucent areas in the center. This
is accomplished by setting different opacity levels in Photoshop
layers and using them as the icon’s mask data. Experimenting with
these methods can create some exciting effects on the desktop.
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The Work Area - The above screen shots show the central work
area of IconBuilder configured to build for Mac OS “Classic” (16x16
- 48x48 pixels) sizes on the left and “Thumbnail” (128x128 pixels)
on the right. Figure 2 shows the thumbnail icon dynamically scaled
to 64x64 or 50% of its original size. The ability to create icons for
Mac OS X is a feature set of IB Pro.

“Grid” Mode (fig 2) “Aqua” Mode (fig 3)

About the Interface

IconBuilder’s user interface is broken into 4 main sections - the Source Layer, the Work
Area, the Target Icon and the Formatting controls. It is important to know and
understand the difference between these areas and their individual controls to help
you build icons quickly and easily.

Section A The Source Layer - The Source Layer displays the icon data and mask
information you have currently selected in Photoshop. This area of the interface includes
controls to switch color dithering on and off, center the icon in the available work
space, or create an entire icon in a single click with QuickBuild. This area also provides
secondary controls for setting up the work area for icon building. By adjusting the
radio buttons provided here, you can select which resource to add to the icon. Lastly,
the controls for changing the appearance of the background texture/color are provided
near the bottom. This is useful for seeing what your icon looks like against a variety
of user’s desktops.

Section B The Work Area - This is the heart of the IconBuilder interface. Whatever
resources are shown in this area are contained within the icon you are currently working
with. When you build an icon from scratch, you add resources to this area either one
by one, or all at once with the QuickBuild feature. The Work Area has two main view
settings: Grid and Aqua. When building icons with “Classic” (that is from 16x16 pixels
to 48x48 pixels in size) resolutions, you’ll want to select the Grid tab for viewing and
building. When creating or adding thumbnail (128x128 pixel) icons for Mac OS X,
you’ll want to view the work area by selecting the Aqua tab. You can switch back and
forth from one kind of view to the other and IB will remember what resources have
been added and display them appropriately. When building icons for the Windows
platform in IconBuilder Pro, the Aqua tab is not used.

Section C The Target Icon - This part of the interface shows how the icon will look
when saved. This view can be customized to display just the icon’s image data, mask
data or a combination of both (the default). In addition, you can “extract” any
combination of these settings back out to PS layers by pressing the “Apply View to
Photoshop layer button. This is useful for getting complex transparent masks into PS.

Section D Formatting Controls - This is where you select a format to save your work
in, import existing icons, or turn the BuilderTips on or off.

Learn more about IconBuilder at www.iconfactory.com Send support questions to: iconbuilder@iconfactory.com
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A Quick Guide to the Controls
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1. Source Layer View - Displays the currently selected PS layer.
2. Add Data - Adds just the visual data to the grid cell currently

selected in the working area.
3. Add Mask - Adds just the mask data to the grid cell currently

selected in the working area.
4. Add Both - Adds both the data and mask to the selected grid

cell simultaneously.
5. Dither Icon Button - Turn color dithering on or off.
6. Center View - Quickly centers the icon in the Source Layer View.
7. QuickBuild - Click this to instantly add data and mask info to

the entire working area. Pro users can hold down the option key
to QuickBuild both Aqua and the Grid.

8. Manual Controls - Select what grid cell to add data to in the
working area with these controls (or by simply clicking on an
individual grid cell itself).

9. Background Texture Settings - Control which pattern, color
or texture is displayed behind the working area.

10. About IconBuilder - Click here to see more info on the filter.

11. Mode Icon - A way to quickly reference what mode the work
area is in - Classic (16x16 through 48x48 pixel sizes) or
Aqua (128x128 pixels).

12. The Working Area - This grid shows the various bit-depths
and icon sizes that you use to build your icon.

13. Undo - Click this button to revert to the last saved verison of
the currently selected grid cell.

14. Delete - Deletes data or mask info from the currently selected
grid cell. With the cell selected, you can also press the delete key.

15. Grid Tab - Sets the working area to build for standard sizes.
16. Aqua Tab - Sets the working area to build for Aqua. (Pro only)

17. Target Icon File - Shows the current state of the target icon.
18. Apply View to Photoshop Layer - Extract out the target icon

file (data, mask or both) to the currently selected PS layer.
19. Both - View the target icon file by a combination of its data

& mask. Gives the most accurate picture of how the icon looks.
20. Data - View the target icon by just its visual data.
21. Mask - View the target icon by just its mask (outline) data.

22. All Mac OS - Saves icons in the most backward compatible
format. Produces the largest file sizes.

23. OS 8.5+ - Saves only new “icns” resources. Users of pre 8.5
systems, will not see custion icons, but files are smaller.

24. Mac OS X - Saves Mac OS X formatted Icns files (Pro only).
25. Windows - Saves WIN formatted .ico files (Pro version only)
26. Clear - Clears all resources from the working area.
27. Import - Import any icon’s data & mask into the working area.
28. Open - Open and edit any previously saved icon file.
29. Save - Saves your icon in the format currently selected.
30. Done - Click here to quit IconBuilder and return to Photoshop.
31. BuilderTips - Helpful tips and icon info are displayed here.
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An Introduction

Unlike conventional icon editors, IconBuilder utilizes the power of Photoshop for editing
of the actual icons. This has many advantages over stand-alone applications, but it
also requires some re-learning about how to approach the process for icon construction.
This section will give some helpful advice on how set out using Photoshop in combination
with IconBuilder as your icon editor of choice.

Getting Organized

Every icon has to start somewhere, and with IconBuilder, that means creating individual
layers in Adobe Photoshop to use as a launching pad for the filter. Its helpful to know
the maximum size of icon you’ll be building for prior to starting. If you’re creating
“classic” Mac OS icons, then 32x32 pixels is the size you should make your initial PS
document at. If you’re creating thumbnail icons for Mac OS X, then you’ll want to set
your document size at 128x128 pixels.

After you’ve created the file, you might want to completely delete the background
layer from the layers palette. This is not absolutely necessary, but IconBuilder can only
build transparent icons when they are created from individual layers, not the background.

Next, you’ll want to create a new, blank layer for each version (or resource) of the icon
you intend to build into the icon. For example, in order to provide the best looking
icon at millions of colors, 256 colors, 16 colors, and black & white, you’ll probably
need to tweak these individual versions by hand and add them separately to the icon.
Therefore, each one of these different “bit-depths” should be on its own individual
Photoshop layer. This also goes for the various sizes of icons (16x16, 32x32, 48x48
and 128x128). (see fig 4)

If you wish to forego this procedure and create a single millions of color version and
have IconBuilder create the rest for you, this can be done as well. Using the QuickBuild
button, IconBuilder can automatically fill in each resource in the working area without
the time and effort of individual layers, but the quality of the results will vary.

The Advantages of Using Photoshop Layers

Many times when creating icon suites for software, a developer will create a single
“base” icon as the template for the set, and then design multiple variations on that
icon to composite as needed. This can easily be seen in the Macintosh System folder
where multiple folders are present (Extensions folder, ColorSync Folder, Control Panels
Folder, etc). In situations like this, IconBuilder & Photoshop’s advantages become clear.

Because Photoshop layers can be created, moved, re-arranged and have their opacity
level set at will, they become the idea environment for creating large, slightly varied
sets of icons. Create your base “folder” icon on one of the lower layers, and then add
additional layers for each type of element you’ll need to apply to the base folder. We
call this “badging” because you are essentially adding a smaller icon or “badge” to
the larger parent icon. (see fig 5) Badges can even be used to represent the icon itself
in the smaller 16x16 (or list view) version.

One thing to remember when composting - IconBuilder will only recognize the data
in the currently selected layer, so you’ll need to merge or duplicate the multiple elements
into a single, new layer prior to launching the filter. The same can also be said for
setting opacity levels of a given layer when masking.

“Badging” Folders (fig 5) - In the above example, the base template
folder is placed near the bottom of the layers list, while the smaller
elements are placed in their own layers above. This allows easy
viewing and placement of the individual badges. Badges can be
combined, blended, made transparent, etc to achieve a range of
effects.

Setting up the proper layers (fig 4) - In order to ensure the best
looking version of each bit depth and size of icon, you may need
to tweak individual resources and add them one by one to your
icon. Note the 16x16 template layer at the bottom that was used
as a size reference to draw the list view versions here.
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The following step by step tutorial will walk you through constructing your first icon
with IconBuilder. We’ve included the steps here for easy review and printing.

Getting Started

1) After you place the IconBuilder folder into your Photoshop plug-ins folder, launch 
Photoshop and then open the IconBuilder Tutorial.psd file.

2) Zoom the image (somewhere between 600% and 800% is good).
3) Create a new view (View -> New View).
4) Select the entire layer (Command-A).

Using QuickBuild

1) The layer "Run QuickBuild on me" should be selected (see fig. 6).
2) Start IconBuilder (Filter -> Iconfactory -> IconBuilder).
3) Press QuickBuild and the watch the icon being created. If the icons aren't

aligned properly, press Center View and run QuickBuild again. If for some reason
Quickbuild doesn’t fill the grid, press the Clear button and try again.

4) You can delete the 16 color versions of the icon by selecting them in the grid
and pressing the delete key.

5) Save your icon to your Mac’s desktop. Use the name "Aqua Folder".
6) You’ve generated your first icon. Next we’ll tweak the folder you just created.

Press Done and return to Photoshop.

Setting the List Views

Now let’s replace the automatically created list view (small 16x16 pixel) icons with a
custom version.

1) Once back in Photoshop, select the “8-bit (small) icon data” layer and deselect
the “Run Quickbuild on me” layer.

2) Start IconBuilder (Filter -> Iconfactory -> IconBuilder).
3) Select any cell from the FIRST column in the icon grid by clicking on it. It doesn’t

really matter what bit depth, but for this example, click and select the 8-bit cell.
4) Click the Center View button.
5) Hold the Shift key down and press QuickBuild. You’ll see the entire column

get rebuilt with the new small icons.
6) Save your updated icon to your Mac’s desktop by saving over the previous version.

Experiment & Have Fun!

There are many cool things you can do with PS and IB. Here are a few fun things to try:

1) Adjust the opacity setting of any layer and use it as the mask for 32-bit icons. Using
the icon you created above, select the “8-bit transparent mask” layer and adjust
its opacity to 50%. Select Image--> Duplicate--> Select All. Run IconBuilder. Click
on the 32-bit, large sized cell and click Add Mask. Watch the folder become
transparent!

2) If you’re using Adobe Photoshop 5.0, try playing with Layer Effects to see how
drop shadows become smooth, transparent masks in IconBuilder. An example of
this would be to add a drop shadow layer effect to any icon and then Duplicate.
Run IconBuilder and do a Quickbuild to see how the drop shadow translates to an
8-bit mask.

Send any cool tips or tricks you might have about IconBuilder to us at the address below.

Learn more about IconBuilder at www.iconfactory.com Send support questions to: iconbuilder@iconfactory.com
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IconBuilder Building Your First Icon

The Tutorial File (fig 6) - This screenshot of the PS Layers in the
Tutorial file show the various sizes and resolutions you’ll be using
to build your first icon.
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For a complete list of frequently asked questions, please visit The Iconfactory
<http://www.iconfactory.com>. We’ve included some of the more common questions
here for easy reference.

Why won't IconBuilder launch? Check to make sure you're running IconBuilder on
a PPC Mac with at least Mac OS 8.5 installed. If you are and IconBuilder still is not
launching, then check to make sure you're using a PowerPC version of Photoshop.
To do this, from within Photoshop, get info on the program and look for the little
"PPC" letters after the version number. If you don't see this, you're currently running
a 68K version of Photoshop and the filter will not function.

There is a long pause when I run the filter. Why? IconBuilder is not free. The delay
process is the filter's way of encouraging you to pay the registration fee. A great deal
of time and effort went into making the filter as good as it can be. By registering to
eliminate the startup delay, you are telling us you support our efforts to bring you
quality software products. Visit The Iconfactory for pricing and registration information,
and if you like & use the filter, please register it.

I’ve set a low transparency level on my layer, but the icon still shows as 100%
opaque in IconBuilder, what is going on? Because of the way Photoshop handles
individual layers, things like layer effects and opacity settings won’t register in IconBuilder
until you do a (Image -> Duplicate -> Merged Layers Only) command. This will generate
a new layer with your previous settings “fixed” in the layer. IconBuilder should then
read your opacity and layer effects settings. (see fig 7)

I'm getting memory errors when I use IconBuilder. What gives? You may have
Photoshop's memory partition too low. Try increasing the overall amount of RAM
allotted to the program and see if this helps eliminate these error messages.

When I click the save button, it seems to take a few seconds to save the file.
Is there something wrong? This can be due to a number of factors: slow processor
speeds, disk fragmentation, or other software running in your Mac's background. Try
running only Photoshop or optimizing your HD and see if this helps eliminate delays
in saving files.

I've built several icons and then gone back to edit them, but they are not
showing up correctly. What is going on? If you're used to editing icons with a
resource editor like ResEdit or Zonkers, you need to teach yourself NOT to edit the
icons once they are constructed with IconBuilder. Even though the filter saves the icons
as ResEdit files (necessary due to the way the Finder is structured) resist the urge to
open them in ResEdit to tweak them. Doing so will wipe out 32-bit icon data, masks,
and possibly damage the file. If you need to tweak the icon once its built, do it in
Photoshop via IconBuilder.

NOTE: Don't forget that if an icon contains both 256 color and millions of color data,
and you do a simple copy and paste on the desktop, you will loose all data below the
millions (256, 16, B&W) version. This is Apple's way of trying to reduce icon file sizes.
The best way to eliminate this problem is to create IconDropper packs of the icons
you've made and apply custom icons with IconDropper, not by coping and pasting on
the desktop.

How do I report a bug or submit a suggestion? Please send bug reports to us at
webmaster@iconfactory.com as well as any suggestions for features you'd like to see
in future versions of IconBuilder.

Frequently Asked Questions

Duplicate the File (fig 7) - Certain layer settings won’t take effect
in IconBuilder until you duplicate the layer. By doing this, you “freeze”
opacity, layer effects and several other kinds of controls onto the
target layer and allow the filter to build the icon properly.

Learn more about IconBuilder at www.iconfactory.com Send support questions to: iconbuilder@iconfactory.com 8
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The following are a collection of helpful tips and tricks that you might find useful
when constructing icons with IconBuilder. If you come up with any additional tips or
tricks, don’t forget to send them to us at iconbuilder@iconfactory.com!

Know the target platform - Before even one pixel is pushed, you should identify
the platform and OS the icon will be seen on. Why is this important? There are different
color considerations when creating icons between the Macintosh and Windows
platform, or even between OS versions on these platforms! A Mac OS X icon has
widely different properties than an icon built for Windows 98 or NT and so on. Know
where the icon will be seen and used and design accordingly.

Keep it simple - With the introduction on 128x128 pixel icons in Mac OS X, we can
already see the desire for icon designers and artists to move toward more complex,
detail filled icons. While the larger canvas is tempting to “go crazy” on, the fact of
the matter is, most users won’t see these huge, thumbnail versions. Most users will
set their default icon sizes to somewhere between 48x48 pixels and 16x16 pixels.
Knowing this, its important to keep your icons clean, simple and effective. The icon
itself shouldn’t vary in design greatly from one size to another, so what you create at
128x128 should also hold up at 32x32.(see fig 8)

Start designing with the lowest common denominators - The tendency to start
creating your icon with the best possible color scheme is a strong one. The wide range
of colors possible in 32-bit icons makes smooth gradations and unusual color treatments
possible, but what about the 8-bit versions? We are a firm believer that it is much
easier to begin with the limited, all-purpose Mac system palette when starting a new
icon. From experience we’ve found that its easier to add colors and shades than it is
to remove them. This also goes for icon sizes as well. Sometimes its best to get the
32x32 or even 16x16 designed and working right before proceeding onto larger 48x48
or 128x128 versions.

Name and save your layers - One of the things we’ve discovered after making
thousands of icons is that organization really does help. Using Photoshop and its
multiple layers for composting and building icons is a time saver, but not if you can’t
find the layer you’re looking for. Try to remember to name a new layer as soon as you
create it. This will help later on when you all of a sudden have 60+ layers with 16x16
badges on them and can’t find the one with “that widget” you’ve been looking for.
The other half of this tip is as old as computers themselves, but it is worth repeating -
save and save often. Nothing is worse than having just created a bunch of brand new,
ultra cool icons on their layers and have Photoshop crash with unsaved changes. It
has happened to everyone, so try to remember to save your work.

Turn off BuilderTips - Once you get a feel for the controls in IconBuilder, feel free
to toggle the BuilderTips off. This not only gets rid of the constantly changing messages
at the bottom of the UI, but in the off mode, BuilderTips provides additional information
about the current state of your icon. BuilderTips will tell you if you’ve saved your work
yet, and the current file size of the icon. This info becomes invaluable as you learn to
use the filter.

Check out the Read-Me file & Iconfactory home page - There are many more tips,
tricks and helpful hints in the Read-me file that came with the filter, including “Tips
from the Foreman” on making Mac OS X icons. Also, check The Iconfactory home
page for the latest information on IconBuilder and other great icon related software.

Keeping it simple (fig 8) - Apple has made it clear that Mac OS X
carries with it a move towards, realistic, detailed elements in the UI.
The buttons, widgets, icons and more are all polished to a high
shine... but does it make for good design? Take a look at the top
icon from Mac OS X, and a prototype icon The Iconfactory made
for a client. Which do you think is most effective across multiple
sizes? Which do you think is the “quickest read”? You be the judge.
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